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Joe Schoen on Facebook

J

oe Schoen is the owner of The Computer
Guy, a complete in-home computer service company for hardware and software as
well as one-on-one tutoring. He started The
Computer Guy part time in 2006 and has been
full time since June 2010. Joe also has been
teaching general computer classes to the public
at Franklin Public Library since 2006. Joe will
present Facebook to us over the next 2 months.
Tonight, in Part 1, he will cover what Facebook
is, how it works, is it safe, the sign-up process,
and some big no-no's. Next month he will speak
on how to use Facebook daily.
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President’s Message—Snow Cancels General Meeting

W

hat a wild
month
February
was. The brutal
assault by old man
winter played havoc
on the city as well
as the Wisconsin
All-computer Users

If that wasn’t enough, the following
week we were hit with sub-zero temperatures with brutal wind chills. That
triggered the cancellation of the Excel SIG.

snow is melting. Perhaps spring is
right around the corner. I missed
seeing all of you this pass month and
am looking forward to getting back to
normal mode.

Now the temps are rising and the

FYI – there are WAUC memberships
available for Sam’s Club. If you are
interested let me know.

Club.

Bruce Kosbab

I was plowing snow when the blizzard hit. There wasn’t much to do but
wait it out. Anyhow the blizzard triggered the cancellation of the general
meeting.

President
(Editor’s note: In the year 2021 we
may still be talking about this blizzard.)

Board Meeting—WAUC Membership CD Goes to MilwPC

B

27th, 2011.

ruce Kosbab,
Doris Regner, Terry
Harvey,
Tom
Hermann, Len Levine,
and
Bill
Gierich gathered at
the home of Doris
Regner on January

Little did we know at the time of the
meeting that the next couple of meetings would be casualties of the February blizzard. Fortunately we had
communicated to all members how
they would be informed in the event
of such weather-related problems.
We have been having trouble with a
yellow tint projected from the projector onto the screen. Bill called the

Address Changes
If you are changing your email or
home address, please note:
Email address changes should be
sent to Terry Harvey at
terryharvey@wi.rr.com and
Tom Livermore at
exyooper@gmail.com
Home address changes should be
sent to Tom Hermann at
singer@execpc.com

projector company and found the
problem was due to a bad cable
which did not come with the projector. Bill will get another cable to rectify the problem.
Bill will have a CD-ROM for February.
Doris took the CD made by Avis
Davidson, Bill Gierich, Jim Hahn,
Judith Hornburg, Ray Jamroze, Tom

Livermore, Ginny Splinter, Ted Torkelson, and Phillip Walker to Troy at
Milwaukee PC. This is an informational CD telling of the benefits of
belonging to WAUC. Troy said he
will look at it and if he likes it he will
run it nonstop in the Greenfield Milwaukee PC store. As of this time he
has not watched it.
We are looking for suggestions from
new members on how to recruit new
members. Please contact a board
member with your idea.

Terry Harvey

WAUCtalk
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Rechargeable Batteries—Notes

I

n the talk “Rechargeable Batteries, How to Use and
Caress Them,” Len
Levine began with a
discussion of some
of the terms used in the power domain. He defined Energy as work,
like lifting a weight a given distance
and Power as the rate of doing
work.
Power, in the electrical business is
usually measured in watts, and energy is measured in watt-hours. He
discussed the cost of household
electricity as being about twelve
cents per kilowatt-hour while the cost
of energy from non-rechargeable
batteries can cost hundreds of dollars per kilowatt-hour. There is a
high price to be paid for portability. This justifies the use of rechargeable batteries for many small
devices. There are problems, however. First, portable batteries often
lose about one fifth of their initial
charge within a day or so of recharging and then lose most of the rest
over the next few months, even
when they are not put to use.
Second, when single batteries are
used in equipment things are very
simple. However, when banks of
such batteries are used, such as the
four batteries used in many cameras,
strange problems often develop.

WAUCtalk

from January Meeting

For example, if a single battery of a
four-battery group has a significantly
lower total charge than the other
three, not only will the voltage drop
when the weak battery becomes exhausted but that battery will begin to
be reverse charged during its last
usage which will permanently decrease its capacity further making
the set of four seem to be weaker
and weaker with time and recharging.
Most important, there is no way to
tell which is the weak battery since
the charging stations often used
have no metering devices on them
and the weak battery often tests just
fine when used with no load.

charge a set of batteries, but can
result in overheating and even exploding a battery, although no examples of such serious problems occur
if normal currents of about 200 milliamps are used. Some examples of
the use of the La Crosse charger
were addressed.
After the talk there were several excellent questions.

Note submitted by Len Levine

Simple battery chargers offer no help
in diagnosing the problems with
these batteries. There are, however,
a few devices, such as the La
Crosse and the Powerex battery
charger, that allows the user to examine each battery of a set as it is
being recharged and determine its
characteristics compared to the rest
of the set.
These more complex devices also
allow testing of each battery and in
some cases improvement of the battery by multiple deep discharge and
recharge cycles. Other changes,
such as change in charging current
can reduce the time it takes to re-

Mac SIG—Sharing Programs

P

eter Lee and Ray Jamroze
were the only ones who made it
through the snow to the MacSIG
on February 9.
They reviewed
some of the next lesson plan on
topics in Section B of the CD.
Then they doodled with some
websites and took a look at Peter’s new toy with which he can
transfer audio cassettes and LPs

to CD's, etc.
All in all, they gained some educational benefits within the hour and
45 minutes they shared with their
MAC computers. They both have
Windows 7 along with Snow Leopard on their machines, and they
compared notes on various programs and software.
They even had time to review the

latest revised PowerPoint presentation of "Inside WAUC," which
had been passed on to Terry at the
luncheon earlier on Wednesday. They are looking forward to
next month, when good weather
should bring a larger attendance.

Ray Jamroze

http://groups.yahoo.com/group/BoardWAUC/

Page 4

http://www.wauc.info

Internet SIG—Avast, Screensavers, Pogo, Fishdom, .mp4

A

s it was January in Wisconsin,
only six WAUC
members were at
the WAUC Internet
SIG held on January 20th, but two
more came later.
It’s a shame because it was not that
cold for this time of year and for once
the heat in the Speedway conference
room was turned on and it was very
comfortable.

“disable for ten minutes,” or for some
other listed time period.
Terry Harvey had downloaded a free
game, Pogo, and now the Google
toolbar on her Firefox browser has
disappeared. On the Firefox menu
bar, go to View/Toolbar and then
check or uncheck the available toolbars as necessary. Bill also showed
how to download the Firefox Google
Add-on at Tools/Add-ons. The Addon downloaded but he didn’t install it.
By the way, going to Tools/Add-ons

There were a couple questions about
Avast, the free anti-virus software
found on the WAUC disk of the
month. Rex Nielson asked how to
turn off the audio announcements.
Go to the settings selection on the
upper right of the screen, make the
selection to turn them off, and click
the OK button. Dick Reinhard asked
if Avast has to be disabled to run his
install disk for his printer. Bill said it
shouldn’t make any difference but if
one wants to do this, right-click on
the Avast icon and then select,

While we were at desktop settings,
Richard Durand asked how to find
the files for screensavers. These files
have the extension “.scr,” and can be
found in the System 32 sub folder
under the Windows folder in Explore.
We tried one of the screensaver files,
the aquarium screensaver, and it
looked pretty cool. There are setting
options for this screensaver that let
the user even select which fish show
up on the screen.
Terry added that it’s worth searching
for, downloading and installing, a
free
computer
game
called
“Fishdom.” Richard Durand asked
about how to play video files with the
“.mp4” extension on Windows. Bill
said the “VLC” program on the CD of
the Month might play this file type or
one can convert the file to something
that will play in Windows. One of the
previous CDs of the Month had “Any
Video Converter,” which can also be
found free at www.any-videoconverter.com.

The SIG began with a non-critical but
annoying situation in that the club’s
projector gave off an unsightly yellowy shade to the computer images
on the conference room screen. No
adjustment to the projector or the
computer could correct the problem.
A different computer was connected
to the projector and gave the same
effect, so the problem seems to be in
the projector, not the image source.
Once we were connected to the
Internet, Bill Gierach entered a
search on Google for the Optoma
DS317, the projector’s model number. There was a possible answer at
www.fixya.com and we found the
projector manual online at the wellknown website for equipment manuals, www.retrovo.com. Bill will look
into this situation before the next
meeting as we couldn’t spend any
more SIG time on it. We proceeded
with the discolored projection and
after a while got used to it except
that sometimes we couldn’t see progress bars that were running.

different selections offered.

will open up a window showing which
Add-ons have been installed. It was
also pointed out in our Firefox discussion that a toolbar for Bookmarks
can be added to the Firefox browser
by going to Bookmarks/Bookmarks
Toolbar.

Richard also said he was having
trouble downloading some archived
radio programs. Don’t just left double-click on the download link. Rightclick on the link and select “Save
As.” The process can be improved
by using another program, which
works with Firefox, on a previous CD
of the Month, “Download Accelerator
Plus 9.5.03,” and which can also be
downloaded
free
from
www.speedbit.com.

There were some other computer
questions asked. Terry Harvey said
that the Start button on Bob Harvey’s
laptop couldn’t be re-positioned to
the bottom of the desktop. Terry will
be bringing this laptop to the WAUC
Board meeting to show exactly what
the problem is.

And that’s what happened at the
WAUC Internet SIG for January
2011. There is always plenty to learn
and re-learn about computers and
this is the time and place for it. Take
advantage of your WAUC membership and come to future Internet
SIGs, even if you don’t have questions.

Dick Reinhard said the icons on his
desktop seemed to rearrange themselves at will and wanted to know
how to re-set them. Right click on the
desktop, select the first option,
“Arrange icons by,” and then try the

Submitted by
Richard Durand
WAUC Member
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MS Excel SIG—Using Formulas to Manipulate Information

T

he
complete
content of Excel SIG
tutorial for Chapters
3 and 4 will be sent
later in a separate
email. Highlights of
Chapters 3 and 4

follow:
Chapter 4 - Creating Formulas
Range Formula Syntax
In the Formula Bar, you will see the
range formula syntax begin with
"equal sign". It begins every formula
in Excel. Next is the name of the
Function (Sum, Average, Min,
MaxO) and the cell range upon
which you are performing the functions (It will always be enclosed in
parentheses). Additional syntax symbols are:
: Used to separate the first and last
cells in a cell range. It is equivalent
to "through" in English.
, Used to separate items in a list
(e.g., B2:C5, G2:H5). It is equivalent
to "and" in English.
$ Used to denote an absolute reference (Its location will never be
changed).
Simple Formula Syntax
In the Formula Bar, you will see the
"equal" sign which always begins
every formula in Excel. Then each
cell's address can be referenced with
mathematical operators used to connect the cell addresses. The mathematical operators used in Simple
Formulas are:
+ Addition
- Subtraction
* Multiplication
/ Division
() Sets up the order of operations.
For example: =F4-(9-3)*-2.
%
Percentage. For example: =
C2*20%
^
Exponentiation. For example:
=3^4 is the same as 3*3*3*3.
Writing Formulas
2 Formula Methods - You use formulas to perform mathematical functions on cells. The two ways of writ-

ing formulas are: Range Syntax or/
and Simple Syntax. Syntax is a way
of writing something.
Write Formula - To write a formula,
click the cell where you want the results of the formula to appear. Then
write your formula in the cell or its
Formula Bar. Note that you don't use
spaces between elements in the formula. Also, the elements are not
case sensitive. Exit the cell to display
the answer to the formula you wrote.
Again, this is the concept of "content
versus display". The actual content
of the cell will be the formula in the
Formula Bar, but the cell will display
the answer to the formula in the
worksheet.
Exit Formula Bar - To exit the Formula Bar, use your keyboard or click
the checkmark in the Formula Bar to
set the formula.

lated first.
Exponentiation, then multiplication and division, and finally
addition and subtraction.
Type a right parenthesis.
Leave the cell in order to save the
formula and display the answer.
Recalculate Cell References - Formulas that use cell references will
automatically be recalculated when
you change the values in the cells
referenced by the formula. This is
one of the best features of Excel.
That is why one rarely finds numbers
entered into a formula.
Using AutoSum
Definition - Excel has a feature AutoSum to automatically sum columns
or rows. One way to use this feature
is use your mouse to click and drag

Display All Formulas - To show the
actual formulas in the worksheet, you
can press the Cntl key and the`
(single left quote mark, to the left of
the number 1 on your keyboard).
Press these two keys again and Excel will toggle the worksheet between
displaying answers and the formulas.
Range Syntax Formulas
Select the cell you wish to enter the
formula. In the Formula Bar, always start with equal sign (=).
The equal sign prevents Excel
from interpreting the info as simple text entries.
Type the name of the function you
wish to perform on the cell range
(s).
Type a left parenthesis.
Enter the cell range upon which you
wish to perform the function or
you may more commonly use the
cell references with standard
mathematical operators. The
standard order of operation is:
Operations are performed left to
right.
Anything in parenthesis is calcu-

over the correct ranges of cells to
use in the formula, including a blank
cell(s) at the end of the columns or
rows where you want the answer(s)
to appear. In the Ribbon, in the Formulas tab, and in the Function Library group, select AutoSum once to
add the selected columns/rows and
display the answer in the blank cell
(s) which you selected.
Intersecting Column-Row Usage - If
you use AutoSum on a cell that is at
the intersection of a row and a column, AutoSum will attempt to use
the data in the column versus using
the data in the row. If needed, you
can change this initial Excel selection
by clicking and dragging over your
(Continued on page 6)
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desired cells.
Using Additional Functions - If you
want additional listed functions, select the AutoSum drop-down menu
and then select Average, Count
Numbers, Max, Min, or More Functions. The latter will open the Insert
Function dialog box where you can
select from Excel's available functions.
Inserting Functions
Begin Insert Function - You can use
several ways to insert functions into
a selected cell:
•
In the Ribbon, in the Formulas
tab, and in the Function Library
group, select Insert Function or
•
Select the insert fx function button in the Formula Bar or
•
In the Ribbon, in the Formulas
tab, and in the Function Library
group, select the drop-down menu of
any function, and at the bottom select Insert Function.
Insert Function Dialog Box - Search
By Words
In the Insert Function dialog box,
search for a function by typing a few
words to describe what you want to
do into "Search for a function:" text
box, and then select Go to the right.
Under "Select a function:" text box, a
list of functions you may want to use
appears. Select a function shown to
see a description of its function and
syntax in the area below.
Insert Function Dialog Box - Search
By Category
You can also select the "Or select a
category:" drop-down menu to select
a category of functions top view for
your desired function.
If you select All category, an alphabetical listing of all Excel functions
appears in the "Select a function:"
text box. Select a function you want
to view to see a description of its
function and syntax in the area below. After you have selected your
function, select OK to open the Function Arguments dialog box which is
where you complete the formula.
Inserting Known Function & Its Category - If you know your function and
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which category the function is in, you
can streamline the process. In the
Ribbon, in the Formulas tab, and in
the Function Library, select your
function. This will bypass the Insert
Function dialog box and open the
Function Argument dialog box.
Select Function Arguments - Select
the arguments which are needed for
the function to work. Arguments are
generally cell addresses or ranges.
To select a cell or cell range, select
the small red, white, and blue Collapse/Expand dialog box at the right
end of any argument to collapse the
argument into a single line. Then
drag your mouse over the cell or cell
ranges to complete your argument.
When finished, select the red, white,
and blue Collapse/Expand dialog box
at the right to expand it to its full size.
Repeat this process for each argument of your function. When finished,
select OK in lower right corner and it
will display the result in selected cell
of your worksheet.
Editing A Range
Resize Cell Range - After a formula
has been created, you can edit the

cell range reference in the formula.
Double click on the formula cell. Now
it will display itself as the formula
instead of the answer to the formula
and put a blue border around the
selected range in the formula. If your
formula references more than one
range, each range will have a different colored border such as green
and purple. You can resize what is
being calculated by moving your
mouse pointer over one of the four
resizing handles in the corners of the
colored borders until it turns into a
two-pointed black resizing arrow.
Click and drag to resize the range

http://www.wauc.info

reference.
Additional Drag Cell Range - You
can also move your mouse pointer to
anywhere (except the corners) in the
top of the colored border until it converts to a four-pointed arrow. Then
by clicking and dragging the cell
range, you will move the calculated
cell range to a new location. Your
formula will change to reflect this
new range it is calculating.
Formula AutoCorrect
If you mistype a formula (e.g. extra
operators, extra spaces, incorrect
order), Excel may be able to correct
your formula syntax automatically.
When you exit the cell, Excel will display a dialog box which offers to correct the mistake. To accept Excel's
solution, select Yes. Select No if you
want to correct the formula yourself.
AutoCalculate
Definition - AutoCalculate is a tool
which displays the results of simple
functions in the bottom Excel row of
the Status Bar. The default displayed
functions are Average, Count, and
Sum. After you select a range of
cells, look at the right side of the bottom row Status Bar for these named
functions.
Change default Functions - If you
wish to change the default functions
displayed in the Status Bar by AutoCalculate, right-click the Status Bar.
In the pop-up menu, you will see a
check mark in front of the names
which are currently being displayed.
Unchecked functions are not being
shown. Select the name of a function
to toggle its display between "on"
and "off" in the Status Bar.
Chapter 5 - Copying & Pasting
Formulas
Relative References & Absolute
References
You can cut/copy and paste numeric
or text data in to other cells, but
copying cells containing formulas is
tricky.
Relative Referencing - Formulas
automatically adjust their cell references to fit their new location. This is
(Continued on page 7)
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an example of the default relative
referencing. For example, if you
typed a formula into cell A5 which
adds cells A2 through A4 and then
copy and paste the formula from A5
into A6, the newly copied formula
would change the cell references to
add cells A3 through A5.
Absolute Referencing - Also, the formula will still continue its reference to
its original cells, regardless of where
you paste it. The answer will not
change because it still refers to its
original cell range. This is absolute
referencing.
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WAUCtalk

- When pasting multiple cells, it is
good to display the clipboard to
make sure your elements are not
lost. In the Ribbon, in the Home tab,
and in the Clipboard group, select
Clipboard button in lower right corner. It will show the copied items in
the Task Pane on the right side.
Clipboard Pasting - If you want to
paste something from your displayed
clipboard, select the item you want to
paste in the clipboard into the se-

Cutting, Copying, & Pasting Data
Pasting Single Cell - To copy or cut
cell, select the cell; in the Ribbon, in
the Home tab, and in the Clipboard
group, select Copy or Cut. The selected cell will have a blinking border
around it to indicate it has been copied or cut into the clipboard memory.
Select the cell you want to paste the
data into. In the Ribbon, in the Home
tab, and in the Clipboard group, select Paste.
Pasting Multiple Cells - If you copy/
cut multiple cells, for pasting, you
can select only the cell which will be
the upper left corner of the pasted
data. Excel will paste them down and
to the right from the selected cell.
Display Clipboard With Multiple Cells

Reminder About Formulas - Cutting
and pasting formulas results in absolute referencing; copying and
pasting formulas results in relative
referencing. The latter is because
when you copy a formula to a new
location. You want to adjust its cell
references and perform the same
calculation with the new cell data
from the new location.
AutoFilling Cells
You can use the AutoFill handle to
copy formulas across rows and down
columns. Select the cell that contains
the formula you want to copy to adjacent cells. Move the mouse pointer
into the lower right corner of the fill
handle where the mouse pointer
turns into a small black cross. Then
click and drag across the row or
down the column to copy this formula
to the other cells.

Create Absolute Reference - You
can create a cell's absolute reference
by placing a dollar sign ($) in front of
both the column letter and row number in the cell reference. For example, if cell A3 is an absolute reference in a formula, use $A$3 in a formula.
Mixed Referencing - Double-click
your formula to edit it (or click into
the Formula Bar). Then select the
cell reference in the formula (not the
cell) you want to change into an absolute reference. Each time you
press the F4 key, you will toggle between Mixed, (part absolute and part
relative), Absolute, and Relative. For
example, if you selected cell E4, it
would toggle between $E4, E$4,
$E$4, and E4.

Hold down the Ctrl key on your keyboard; then select your cell/cell
ranges, and drag and drop the cell
range. Finally release your Cntl key.

lected cell of your worksheet.
Delete Clipboard Copied Items - To
delete copied items from the clipboard, select the item in the clipboard and select the drop-down arrow to the right; then select Delete.
Delete Entire Clipboard Contents
delete the entire contents of
items copied into the clipboard,
lect the Clear All at the top of
clipboard

- to
the
sethe

Close Displayed Clipboard - To close
the clipboard display, select the "X"
in the upper right corner.
Alternative Cut/Copy & Paste - Drag
& Drop - You can cut, copy and
paste using your mouse with the
drag and drop method by selecting a
cell or cell range, but not multiple,
non-adjacent cell ranges. For the
latter, you have to use the Cut or
Copy buttons.
Drag & Drop For Cut & Paste - Select your cell(s). Then drag to your
new location. The cell outline will
follow you to the new location.
Drag & Drop For Copy & Paste -

The Undo Button
Definition - The Undo command lets
you undo the last command you performed. In the top Quick Access toolbar, the Undo drop-down arrow contains the list of the last few actions
you have performed. You can reverse anything on this list. However,
you must reverse them in the order
that they were executed. If you want
to undo action 3 actions ago, you
must undo the 2 actions which followed it.
Exceptions - Some actions cannot be
undone. For example, if you closed a
workbook
without
saving
the
changes, you cannot reverse this.
The Redo Button
The Redo command reverses any
Undo command action. In the top
Quick Access toolbar, select the
Undo drop-down arrow contains the
list of actions. Select any action in
the Redo list that was accidentally
undone.
More to come in the next issue.

Ginny Splinter

http://groups.yahoo.com/group/BoardWAUC/
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Word vs. Open1998,
Office—
Office Suite Standoff
Star Office version 5.0 was fice.org vocabulary. Late in 2010 a

A

n office suite is a software
product that includes a group of programs which perform typical office
functions; that is, creating and working with documents, spreadsheets,
presentations,
and
databases.
Some suites include specialized programs like email or calendars. There
are many office suites available,
such as Corel's WordPerfect Office,
Lotus Symphony Suite by IBM, and
ThinkFree3. Among the best known
suites are Microsoft Office and
OpenOffice.org.
My original intention this month was
just to compare features and compatibility between Microsoft Office
and OpenOffice.org. I installed
OpenOffice.org on my computer and
have been testing it against my familiar MS Office for several months. In
researching the history of the two
suites, however, I stumbled across a
story that I felt needed to be part of
this article. Let's start with that.
History Microsoft introduced its Office suite in 1992 with Office 3.0. It
included Word, Excel, PowerPoint,
and Mail (later to become Outlook).
Since that time, the suite has expanded to MS Office 2007, which
comes in eight versions that include
from 3 to 13 programs and runs on
both Windows and Mac platforms.
MS Office 2010, its newest suite, has
reduced the versions to three, including 4 - 7 programs. Because it is a
commercial product with a profit
goal, MS Office is expensive, although non-profits can get substantial discounts through websites like
TechSoup, and businesses can get
deals on volume licensing. Office
2007 and 2010 are full-featured
suites with frequent updates and
great customer support and security.
OpenOffice.org has a different kind
of history. The origins of OpenOffice.org (OOo) began in Germany in
the mid-1980's with a suite called
Star Office, created by the Star Division Company. It ran on several platforms, including Windows 98 and
NT, Solaris, Java!, and Linux. In

offered free to users. The next year
Sun Microsystems purchased Star
Division, mainly to get free software
for its thousands of employees and
to compete with Microsoft.
In 2000 Sun first offered the source
code for Star Office 5.2 free over the
Internet. In October, the new
OpenOffice.org website went online
both as a free downloadable office
suite product and a collaborative project. Anyone could participate in improving the suite by submitting ideas
or code. OpenOffice.org immediately
became popular; the open philosophy was embraced by software developers around the world. By 2005,
the free suite had reached 20 million
downloads and over 150,000 registered members. It was a David and
Goliath situation: big corporation versus the little guys.
All this time Sun had also continued
to market its commercial office suite,
Star Office, for a nominal cost to
businesses, but free to educators. In
January 2010, the large company
Oracle bought Sun Microsystems
and acquired the OpenOffice.org
brand. Before that year was over,
Oracle had stopped making Star Office free to educators and had introduced a new commercial product,
Oracle Open Office (standard version for $49.95 for 5 users or and
enterprise version for $90.00 for 25
users). Oracle is planning to offer its
own office suite soon, an online
product called Cloud Office, using
Java FX and open document format,
but not based on OOo code. It will be
competing against the new rash of
"cloud" office suites, such as Google
Docs and Microsoft's Web Docs on
SkyDrive.
As 2010 ends, the OpenOffice.org
website remains intact; the suite is
still a free download. But some Sun
developers and many OpenOffice.org contributors are unhappy
about changes that Oracle has made
and worried that the company will
soon
remove
"free"
and
"collaborative" from the OpenOf-

new organization, this group formed
the Document Foundation (TDF), to
keep the open philosophy alive. They
are working on a new office suite,
LibreOffice, which is now offered for
free download in beta. Its final version, based on the OOo code, is
scheduled to come out in early 2011
with sponsorship from Novell, Red
Hat, and IBM. How all of this drama
will impact OpenOffice.org as a product is unclear. But the little guys are
again making a stand against another Goliath.
Feature Comparison MS Office
clearly beats OpenOffice.org in features and formatting options, especially those introduced with Office
2007, such as themes, Quick Parts,
picture styles, Word Art, macros, and
content controls. Office 2007 offers
encryption, more templates and an
extensive Help system. It also has
the new ribbon interface, whereas
OpenOffice.org uses menus like MS
Office 2003.
OpenOffice.org includes the common
programs found in an office suite
plus some interesting features such
as font effects, backgrounds, and
sounds. It is a solid office suite, especially for home and small business. Its advantages over Microsoft
Office are cost (It is free with an
unlimited number of installations.), its
ability to work with Linux and many
other operating systems besides
Windows, and its open philosophy.
OOo runs a bit slower than MS Office, but takes up less disc space.
Because it is a collaborative, it issues fewer updates and has fewer
support options, but it also is less
frequently attacked by malware.
Even if you have never used an office suite, you can download this efficient
little
suite
at
www.OpenOffice.org and use it without much instruction.
Compatibility As a Microsoft Office
user, I was interested in how easy it
would be to save files between the
(Continued on page 9)
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H

ere are the
minutes of the
WAUC Investment
SIG for January
2011:

In the fall of 2010,
the WAUC Investment SIG received advance information that the usual meeting location,
the conference room at the Speedway Station at 60th and Layton in
Greenfield, would not be available on
the scheduled meeting date for the
first SIG of 2011, January 26th. That
gave plenty of time for plans to be
made. The SIG met on the appointed
date at its usual alternate location,
Panera Bread at 7814 W. Layton.
There is a free wifi signal at Panera
and since it closes at 8:00 p.m., the
SIG met at 6:00 p.m., an hour earlier
than its usual time. We were able to
get one of the larger sized tables for
our group, and though it was busy
and noisy at the dinner hour, we
made up for it with our own volume.
Without the presentation facilities
available at the Speedway conference room, the SIG was a lot more
informal and we pretty much just
looked up quotes and charts for various stocks and this turned out to be
a nice change of pace.

Printer Available Free
FREE PRINTER AVAILABLE. Kris
Bedalov has this Epson Stylus,
Color 600 InkJet printer.
The user's
guide
is
dated
1996. The printer reads in the manual as EPSON 360 dpi, High Quality, and Photo Quality InkJet Paper. The ink cartridges read: black
S020093; color S020089. The
printer can be used with a PC or a
Macintosh, and has a CD to load its
program. The manual is included.
The warranty card is still in the
package, too.
If you are interested, call Kris at
414-255-8554.

Present at the SIG were WAUC
members Richard Durand, Don
Gardner, Rex Nielson, and Dale Voit.
Richard relayed that fellow WAUC
investor Glen Ehnert sent his regrets
for not being there to tune in to a
scheduled webinar on currency trading but that, if all went well, he would
be giving a presentation at the next
SIG in February. We are all looking
forward to it.
With a Wi-Fi signal and Richard’s
netbook, we connected and went to
one of our favorite investment websites, www.stockmaven.com. Dale
had several stock possibilities, beginning with Check Point Systems,
CKP, which markets bar coding systems, and just recently came close to
its 52 week high.
Next was MTOX, Medtox, a medical
company offering testing for poisons.
It has a high price earnings ratio,
known as the P/E, but has a good
looking chart, and the technical indicators show it to be a 96% buy.
We checked back on one of Dale’s
recommendations from several SIGs
ago, ZAGG, Zagg Inc. It has fallen
off a little and is now rated as only a
56% buy.
Don asked for a lookup of one he
had just sold, EOI, Eaton Vance, an
Exchange Traded Fund, also known
as an ETF. He had good timing because it’s now in a down trend. Don
then got into famous investor Warren
Buffet’s security, Berkshire Hatha(Continued from page 8)

Open Office
two suites since I have hundreds of
Word documents and Excel
spreadsheets. When I created a
feature-filled Word 2007 document
(.docx) and saved it as an OpenOffice.org file (.odt), it did save, but
there were changes in margins and
line spacing, and I lost all the Word
2007 features. When I created a
document in OpenOffice.org (.odt),
it would not save as a Word 2007

way, symbol BRK.B. The shares are
expensive, but it’s at least a good
short term buy, according to the
screen.
Next, we looked up the local energy
company in Manitowoc, Orion Energy, that President Obama had just
visited. It took a while to find the
stock symbol, OESX, because there
are an unbelievable number of different companies named “Orion.” Once
found, it had a rating of a 100% buy,
though it had lost .17 cents that day.
Dale then told us about another exciting local company, ZBB, Zbb Energy, that has an advanced battery
technology that could be huge. The
current chart activity isn’t compelling,
but Dale stresses getting it now while
it’s affordable because in the long
term, one to five years, there could
be massive gains.
Some other stocks we looked up
were CIM, Chimera Investing, JCI,
Johnson Controls, IBM, International
Business Machines, and the big domestic car companies, F, Ford, and
GM, General Motors. We had a great
time with our various lookups and
general market conversation, and
before we knew it, Panera Bread
was closing and we had to pack up.
Until next time, these words from the
famous Joe Paterno apply to investing and life in general as well as to
football: “The will to win is important,
but the will to prepare is vital.”

Richard Durand
document (docx). I had to save it
as a Word 2003 document (.doc),
and then open it with Word 2007 in
compatibility mode.
I concluded that it's best to choose
one office suite and stick with it. In
short, if you are a current MS Office 2007 or 2010 user, you will
probably be happier staying where
you are. If you are new to office
suites, by all means give OpenOffice.org a try.

http://groups.yahoo.com/group/BoardWAUC/
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http://www.wauc.info

WAUC’s Official
Internet Provider

BREW CITY GEEKS
Is your computer not performing
the way you would like?

WE CAN HELP
FREE ESTIMATES
Computer upgrades/service
Custom built PCs
In home networks
High speed internet set-up
Trade in your old computer

PLEASE
CALL US TODAY
JIM: 414-704-7439
BRIAN: 414-313-3709
Email: packfan4life@wi.rr.com
Email: brian47@wi.rr.com

In appreciation for the use
of their conference room,
please patronize Speedway gas station
at 60th & Layton.

WAUC
Wisconsin All-computers User’s Club
P.O. Box 340241
Milwaukee, WI 53234-0241

First Class

